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XE. Oracle WebLogic Server, Oracle Application Development Framework (Oracle ADF). Java, 3 & U'Oracle
VM Managerz v — 7 )VEBRY —N—ZAf VA h—VT 5, VU TNRA VA M—VERLET, ZOA
VAR ATV 3 T A MBIOEREFRECHERA L EY, ARREDYS AL, Oracle VM Installation
and Upgrade GuideZ# &M L C, 1A v A b= DA T v a v EiidVT— b « T—F_R—=ZA&HHT5
AL VA N— DA T a UERIRLTLLIEEN,

# cd /mnt
# Iruninstaller.sh

Oracle VM Manager Release 3.0.1 Installer

Oracle VM Manager Installer log file:
/tmp/ovmme-installer.selfextract_ZD2420/install-2011-08-01-132546.log

Please select an installation type:
1: Simple

2: Standard

3: Uninstall

4: Help

Select Number (1-4):1



http://download.oracle.com/docs/cd/E20065_01/doc.30/e18548/toc.htm
http://download.oracle.com/docs/cd/E20065_01/doc.30/e18548/toc.htm
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AVAN—TIZEY | BATANCAHRGERH 2SN TV DN E I DR I, TOHRIZ/IAT—FOA
HERDLZTu L T IRFRENET, TORRT—=RIFIA VA M—=ILDRETH, A VA =T 5T
NRTOMBTHERAEINDT 744 bO/XRAT— K, 8L W0racle VM ManagerdO 2 —H— « f ¥ 7 = —
ADOTA v e NRAT— RIZRD E3,

Verifying installation prerequisites ...
*** \WWARNING:Recommended memory for the Oracle VM Manager server installation is 3950 MB RAM

One password is used for all users created and used during the installation.
Enter a password for all logins used during the installation:
Enter a password for all logins used during the installation (confirm):

AVAP=TIZESTRRAT = FERBROEMEPHER SN, QB OGITEERT DA vt —V0B#E
IRENET,

Verifying configuration ...

Start installing the configured components:
1: Continue
2: Abort
Select Number (1-2):1

EBEOA VA M=/ - TrEAZ, BOBTRO LI RABERERINT, SN ET, A VA b—
Lo T AR TR20~305 000 £,

Retrieving Oracle Database 11g XE ...
Installing Oracle Database 11g XE ...
Configuring Oracle Database 11g XE ...
Installing Java ...

Creating database schema ‘'ovs' ...
Retrieving Oracle WebLogic Server 119 ..
.Installing Oracle WebLogic Server 11g ...

Installing Oracle VM Manager Shell & API ...

Copying Oracle VM Manager shell to ‘/usr/bin/ovm_shell.sh' ...
Installing ovm_admin in ‘/u01/app/oracle/ovm-manager-3/bin’ ...
Enabling Oracle VM Manager service ...

Oracle VM Manager installed.

Oracle VM Managerf > A h—/LDFE T, ROERBFRINET, A VA F—AFZEDRA vE—VITIE,
Oracle VM ManageriCB+ 2 HEREWRNE I N TNWDEED, 4%, 2RTIB5AICMATTI AL -
T 7 AMRFEL TR TSN,

Installation Summary

Database configuration:
Database host name : localhost
Database instance name (SID) :XE
Database listener port 11521
Application Express port : 8080
Oracle VM Manager schema : ovs

10
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WebLogic Server configuration:
Administration username : WebLogic

Oracle VM Manager configuration:

Username : admin

Core management port 154321

uuID : 0004fb00650100002f72ae7c96celdct
Passwords:

There are no default passwords for any users.The passwords to use for Oracle VM Manager, Oracle Database 11g XE, and Oracle
WebLogic Server have been set by you during this installation.In the case of a default install, all passwords are the same.

Oracle VM Manager Ul:
http://MyManager:7001/ovm/console
https://MyManager:7002/ovm/console
Log in with the user ‘admin’, and the password you set during the installation.

Please note that you need to install tight-vnc on this computer to access a virtual machine's console.

For more information about Oracle Virtualization, please visit:
http://www.oracle.com/virtualization/

Oracle VM Manager installation complete.

X6 : Oracle VM Manager{ YR h—3JI2& 2 TRREENZ M VR F—ILEDEELER, COBHRODIE—IL. T CIZERY HE HI5FFIC
BRELET,

AVAPM—NVDOFETIZUEREKEZATIZ, VNCTTA T e VA M—=VT5H5ZLTT, VNCI F
AT b A R—)L9 5 & T, Oracle VM ManagerZz £/ LT, Oracle VM~ % ks ECTEITEN5
avy—)betyaryEEighcE £7,

# rpm -ivh http://oss.oracle.com/oraclevm/manager/RPMS/tightvnc-java-1.3.9-3.noarch.rpm

Retrieving http://oss.oracle.com/oraclevm/manager/RPMS/tightvnc-java-1.3.9-3.noarch.rpm

Preparing... it T [100%]
1:tightvnc-java HHEHHHEHE T (100%0)]

B7 : VNCH—I—DA VX k=)L - TAOEZR

ORI, TightVNCO A A h—/L &R L TWETA, BEORealVNCE ROV ICHERTHZ L b TE,
BAEIC Lo TEZEOFN, ~ v A %Z L OBORICITS 2 &N TEET, £z, Oracle Linux 61213,
TigerVNC & W ) TightVNCOIRAE R AN E LT3 Y . Oracle VM Manager % Oracle Linux 6121 > A h—/b
T H5E1E, TightVNCTIE72 < TigerVNC A L T 72 &0y,

11
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Oracle VM Manager~® R4 A >

Oracle VM5 v k7 + —LO#EE
3 ] Oracle VM Managar
‘ . H 4/'917-1—_1'\03
=78
ZORERTIIM IR T 2 LER 2 <, WORITTRT L HIC, A= TWDH7 7 7% TOracle VM

Manager® t—H%—« £ > X 7= —2 (Ul) IZHHRTE D MERH Y £3, Oracle VM Manager UID T 7
THDOURLIL, L THRIELIZA A b= BOFHIC, ROX S ICRESNTWET,

http://MyManager:7001/ovm/console

"admin", 35 L UOracle VM Manager® A > A h—F 3T L1 & IR ELTZRA T — REHEH LT,
Oracle VM Manager Ullz e 71 > L £,

ORACLE vM Manager

8 : Oracle VM Manager®1—H#—+ 4 V4 Jx—XROBJ A VEEA

RDRATY T
Oracle VMPEF‘UD/v— R =7 « 7Ty F 7+ —LWN5%ET LIZDOT, Oracle VM Server”— /L& B9 %
WDOEBRAT v SR ET,

12
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Oracle VM Server 7— LD {ERK

D72 —ATiE, YEY—R— Xy b V=7 BLOA ML —V2 Y V=L LTENTSHZ &T,
H—r3— - F—)L & Oracle VMF A R Z{ERK L7 & Z1Z0racle VM Manager 2D U Y — A E{EHT
XHLIICLET,

A—HY— A VBT IT—ADITA YT - IT—
Oracle VM ManageriZ v 71 > L7214, IefICER R S LD EMEIL Home" ' = —T9, Z DB TiL, Oracle
VM Server, * v hU—27 BIOIMEA FL—URY V—2L LTEMINTHET,

mwmnlupx

Logoed nas admn

ORACLE" vMManager

e ——

nartware L Vew-  Jeor. Wodee.. F)rddRemcie sever P Bloras %
. Resources. s ey=ep ol P .
) Ursssgred Servers

| Cescoten Status Message Abort

Copyrght © 2007, 2011 Orade andjor its afflates. Al rights reserved. Orace YM Manager 3.0

HY: A—H— A VETT—RDIAVY - IT—
Oracle VM Manager=2 > Y — 1D F A v 7 « V7 —TliX, IROMREHZEZ R L TOET,

3 : Oracle VM Manager®a1—4#—+ 4 4 7 1 —XADWEER

&5 WRERA L]

1 FESY—vav-Ea— BEEOFES -3y - RAVTE21—%2FEFTE-HND a—rhAy bTT,

2 oad-RqY 3T RAVIZE, RAVEEL—DY—)LPAa—ZFFALTHKBLEZ2RZI2D0VT
DAYE—T RAT—ER, BLUHRNRTINET, Da3TF. RTD1—ILEHAZRY
ICEEM TN TOERA, Flz. 3T - RAVEIVTFXFRAMUREL TV ER A,

3 BFERAS FERAVIZIK, TEF—2ay - RAUTHRERTHOE2—DIAVTHFRMIE L2 RS,
Y—b. BLUEITBRRSNET,

4 FEF—Y Y- RAY FEF—L 30 - RAVTlR, FES =23y - Y —DA TSz FERYLEHUTEET,

5 BFERAS Y - Y—)L/A— BFERS VTHERTIATVLE 2 TOaVTFRMIRELTVETS,

6 FEAR(Y 4T EEARA VEBLOARY LIERD T IL—TIZRBILET,

13
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FEF—vay - RAY-

W—JLiN—

FEF—vaY - Rq-

AZa—-N—

Y=, FES—T 3

AZa—lF, FEHX—=I3Y

CRAVTRERTRIOE2—DAVTFRAMIAIELTWET,

s RAUTRERTPOE2—DIAVTHFR MIRELTLET,

ga—m-yvy
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1)) —RX & L TDOracle VM ServerM#&H

HY—iri—« T—LDER
i } il b b f 3
| Oracle VM Manager | | |
WML T, Oracle |
VM Server® — f— I f

|yy—zé&LThm |

\ L J J J

A

Oracle VM ManageriZ = 27 4 o L7, IAICHRZR 45 BEE L "Home" & = — T3,

Home Help About Logout

ORACLE" vM Manager it e aduin
Vew v Tools » Actons » Hep »
d dla@
Server Pools [o— r— Fvents
vew- /R g
piome eymen e [Pooirie 5ystem__[peacrption

Mo Server Pools found, use New Server Pool... to create one.

alrome
F e ‘

o e 4

Copyright © 2007, 2011 Orade and/or s afflates. All ights reserved, Oracle VM Manager 3.0

10 : "Home"Ea—: 1—H— - A U2 Tz —RITAF A L L%, BPICRTEINIET

E = — % HardwarelCZF 9 521X, B a— « 2 O "Hardware"> 3 — 7 v b &AL E£9, Hardware
E'=—TiL, Oracle VM Server, x> hU—7 BXUINHEA L —URY V—2 L LTGEMShTHET,
Y —22 & LTEIT %0racle VM Serverz 4 511X, S5/ —2a v - U —d [Resources] 7+
NEELE7 Vv 7 LT, A==2—Mm5 [Discover Servers| &R L7,
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ORACLE vMManager

K11 : A =2 —%{#f L 1=Oracle VM Server® &t

WORKNZRTEHIC, $r—=_"—ZBIMLET, KIZRTELIIC, IPT RLAOHFAZFEHTLIZ &,
—EZIoTOBMT A L TEET,

ORACLE" vM Manager
Yeu v Toos v Actors w teb v

L )
thversu'ven L]

¥ Enter 1P Addresses of the Servers.
NOTE: Servers can be spedified indvidualy or in a bst.

SpedfyanPAddress orrange) (10 131 (12 (101 to]100  _Add
DAL 12100
u 02
10.11.12.103 B
[P Addresses
Remave Al

Ovadle VM Agent Port [ 8855
Orade M Agent Passiord | sesessne|

H12 : Y—N—BHEAOFA 705 - Ry IR

K13IZmT L oIc, 7 ' XA TiE, X TOY— 3—23"Unassigned"h— 83—« J YV —Z « 7 —)L|Z
BMEN, BOAT v S TEKT DV — =« F— L) YTHN S E T, Oracle VM ServerlZZ D
VR e LD £,
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Home Help About Logout
nas admin

C I_e ] Manager

yiew » Tools » Actons » Helbo v

B @
& Hardware Server Pools. Networks VLAN Groups Events
IO LI storage W ven- LR @@
B Name. [keymap Virtual 1P |pescrption
¥ (3 Inassoned Servers |
B myserver:
B myserver2
B myservers
=1 <
~ Jobs
Descripnon |status |Message | Ahart
Discover Server 10,156,36.93 Completed Abort
ol ome ‘ Discover Server 10.196.36.92 Completed Abort
|| Discover server 10.196,36.91 Completed Abort

B rerdvare

2011 Orade andjor itz affiiates. Al rights

K13 : #&H S ht=Oracle VM Serverld, H—/3—+ T—)LIZEIY BT 5N 3 FE T'Unassigned" DIREEIZAE S
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BEORY FU—Y DiRE

T Y

o F
ATV = FO&4TL, BT, BIOREROFIL, MEOFAOHREBHE L TREY, EHE2RTLOT
THY FEHA, RSNV R NU4A, VNICES, RA N, Xy NI—J 4, Xy bT—75B

FOFRy hU =27 ORI 560 THY | FEDBRREZMET L 5L L TR LN TE
él/\o

Oracle VM 3%+ 25 &, Fy MU—7 2B B C& £9, Oracle VM Server DO xR > FU—7 -«
TNRARAZH Yy hT =2 »m—L &Y T3y &2FED Y THEHIZ, Oracle VM Manager» HEFTE 5
X572, Oracle VM ServerlZu 74> LT, Xy b U —27 & FEI CHELT B LEMENER S 1
FL7,

FEAEDOT =22 Z—IIFEEOY T2y ERHY, YT Xy M, 22— =B —n"— F—
BR—=RA TV r—va AR TELRE 7R -2 F (X7 Vv r - Xy hT—2), RO
ARL—Y (ARL—=V Ry FU—2) GHOFENF—A"—EFH (FHfxy FU—2) E FE
DO —LR3H Y FE7,

WA & b2y 0 L9 < L7 5, Oracle VM 3D LW T2 SRED — 2 #E 9 572012, 2D
Fa—hUTATHE, 220873y hEBO ANET, 123FBY 7 X% v b T, Oracle VMEREE D7k
SEBOEDIHERLET, bI123F Vs « TRy N T, A R —T L0racle VM7 2 (72
LBRNET —HFRXR—=RALTT Y r—ay) ~O— 7 72 ARERLET,

ERDOY— "= AT v 7 ¢, Oracle VM Manageril k> C1o0Oxy hU—7 3 EnE Lz, =
DOF 2a— Y TATE, RHSINEBEFEOXR Y NV — BNERR Y NT—J RV ET, ROAT v
IZHEA T, BEFOEBR Y N —7 DARTEAEE L, KIZ, A hL—Y, BLWOracle VMF A h~D—
72T 7 AT Y o7 - Xy VU =T ZBIMLET, ARIOEFINLATIERLS, BORAT v
TTHxYy MU= - B UIZBET ARELEBIT 2 72DI21T 9 D TT,

WRDOAT v 7T, BEDFRy NI —ZBREBEICADLE T, Y72y FOL4RIEn— L ZHE L TS0,
HM—pH 7%y FLOARWESIT, BEOR Y NU—27 P ZEE LT, +XTD"Network Use"% Z D1
OOV T FRy MTEIDYTTrL, "Fry M= OMER"AT v 7 2B L T 7ZE 0,

FEHF— g 2 U TResource NER SN TNDHZ LR L, ROXIATTRT XL HIlc, BT
T [Networks] ZE4R L. Networks¥ 7 OE FIZHAHEHY — L R—THRET A 2 BN L 7,
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ORAC Le VM Manager

Networks: VLAN Groups Events
View Ij x|

Hame

o 1 Network Use I
Server Ciuster | | Vrwal  [VLAN Segment

i) ‘Managemeﬂt‘ Heartbeat | Lve Morate ‘ Steage | oine |

10.196.36.0 v v v

B myservers
B myserver2
B myservers

& M >

& Ports L Ethernet Ports
View ~ | Vi Dort Name: | address [Portstats ||

Description [status |Message | Abort

K14 : ResourcesE 1 —Tary kI —H B2 TEREIR

Edit Network” 4 ' — RDF A 707 « Ry 7 AT, Ry NT—JZET 7HNV DY T Xy~ T KL
ANDATEDOXFINCEE TEET, ZOHE, BOAT v 7 TR LT 75720, KI5IZRT XL
2. 4 A% "Management Network" (228 L £,

DQACI_E VM Manager
Yew = ook + Actons = Helb v

ARlagae
—

Hetworks  (EETVRETO T (PN

& Edit Hetwork
) ~ = . = =]
I8 Edit Network SelectServers SciectPoris Select VLAN Segrent  Configure IF Addresses
‘ Edit Network Name and Use
B wyserverz mEs————— -
B Mysenert * Name [ Management network Network Use | 7] crer Management
Description | private network for Orace Y. Fluve mgrate
200 menagement functons
- [ custer keartbeat
O vt machine
Ostorage

15 : v k7 —% % %"Management Network"[ZZEFE

T AP —=RT, EVAODXZ AT ZEDTHWEET, FinishARZ N7 7T 4 TR DHET, fi<TT
DEATOT « Ry ATT 74V MREXZFDOEEFATLET, BRIFIKROKI6D L 51220 F9,
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Le VM Manage;

View » Tooks + Actions » Help v

Rl ae
- tetwors (T
Hardware (TN, vene 3 2R
- Resources. | Hetnork Use
V13 Unassoned Servers | Name: lSered  Server | Clster | I Virtual | |VLAN Segment
M Y] Management | Heartheat | UVEMORAE | SIOBGE | yochne
a My‘Ser-‘-elZ Management netrork v v v
K myservert < | >
CoumnsHdden 1
el
Ports VLAN Segments.
£21 Ports [ 2 Ethemet Ports.
view~ | £ Port Name |P Address |Poct status 1
Port Name
MyServer1 Bond Port (1)
MyServer2 Bond Port (1)
MyServer3 Bond Port (1)
% |
|
1 \
-1
~ Jobs
Description [status [Message | Abort

11 Orade andjfor its affi:

Alirights: reserved. Orade VM Manager 3.0

K16 : "Management network" I B BT ZEE SN =RAIDE Y kT—4
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JY—RELTOEMRY FT—0 DIERR

HY—ri—« F—LDIER

—

A Y (T e e e i I 1 - o S ¥
Oracle VM Ma nageﬂ | |
I— EEMALT. Bl |
== 4 Dy EI—4% |
J “ Jﬂuu--z.':LtﬁﬁJ‘:{ | J

B == L1200 Fy N =V ER LAV ERIE. TORAT v S IE0EH Y £, HiDA
T v ZIZRE - T, Storageds & OWVirtual Machine® x> U —72 « o — L EBEFO Xy MU —Z B L T
<TEEW,

HLOART Y w7 « Xy NT—Z ZERLET, ZHIZEY, Oracle VM Server & Oracle VM Manageriz,
A L=, 2B WNCOracle VMT A b L CBBIT 27 — 4% X—A, 77— a v RELCT7EAT
EHLITRVET, Xy FPU—ZERZ 27 TITHEARIZ, Oracle VM Manager® % v kU — 7 {Eik
7 4 W— KT, Oracle VMEHE NS E2 % hU—ZEHEHANT, BlORy NU—7 « f L H T =—
A7V ¥ % Oracle VM Server b IZHERE L £,

WORITZRTE I, Xy NU—7 « ZTOHETFICHHEHEY —N/3—»1 5 [Create Network] 7 1
IV EEINLET,

Home Help About. Logout

ORACLE" vM Manager Loogedinas admin

View » Tools » Actions » Help ~

hida@
| v scrver poots JRUTRSSIN v Groups N _events W
— Tietnork Use

Server | Cluster
Management | Hearthest

Vitus |VLAN Segment

Live Mgrate |  Storage boirray

Management natwark

L] >
ColumnsHidden 1
e
(SO vviseoments WY
1) Ports | R ethemetports |
view ~ | A PortName 1P Address [PoetStane |
Port Name

MyServer1 Bond Port (1)
MyServer2 Bond Port (1)
MySesver3 Bond Port (1)
&i | 3

k|
-
~ Jobs }
Description |status [Message | Abart
d -
Home: ‘
B Hedvare \
s Joos £ ] =

Copyright © 2007, 2011 Oradle andfor its affliates. Al rights ressrved, Orade VM Manager 3.0

H17 : N— KOz 7EBRA UIZHDBHRY bT—H - 2T T [Create Network] 74 3> &:&EiR

wDOX18IZ7xF & 912, [Create a network with bonds/ports only | % 3&R L 7,
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o Create Hetwork
Select

(@ Create 1 network with bondsjports only
O Create a network with VLANS only

LANS

=
O Create a ingical netwark on 3 single server

18 : Create Network™ 4 ' — FZ#FER L RO EA 705 - Ky v X

WOMINIRT LD, HLnRy b —7 O4RTZFE LT, [Virtual Machine) & [Storage] OF = v
7« Ry 7 AEBRIRLUET, "Network Use"lX, ¥ 7 H o bD T T 4 w7 DX A TERLTVET,

o, Create Network
L = &) &
Create Network Select Servers Select Porte Configure 7 Addresses
Enter
* Name | Publc network

NetworkUse | 7] corver Management
Desaipton | Network that alows users to

access storage and Oracle ¥

quests

H19: RFYT1- 94— FORIMDRT YT T, 7y bT—Y DOLAH. HBE. & KLU Network Use"& AH

LWy T —7 ZAERUMER T % Oracle VM Serverz 3R L %9,
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& Create Hetwork

%, o ) &
Create Network  Select Servers Sslect Ports Configure I° Addhesces

20 : AF v 72 - Oracle VM Server%;&iR

2L R TIRD AT v FIHOWTIE, D LHARKETY, R— hA ¥ 72— R 21X, eth0Lethl 7
EDA U H T 2 —ZADLinuXA IR S EE AN, port(1)ideth0, port(2)idethl: 5 BAICE SN E T,
HAALBREEICEEE T2 b DT A4 Oracle VM Server CHERE T B 72010, W@YIRA V¥ 72— AZEIRL
TLEE,

MyServer3 Port (3) MyServe-3Part (2)
MyServer3 Port (4) MyServer2 Port ()
MyServer2 Port (3) MyServe1 Port (2)

®21 : X7 73 - Oracle VM Server®¥IE( >4 7 1 — R %3&4R

B%ic, AL —Y &0racle VMAZ A2 FHICKHERR L TWA Y7 %y FOIPT KL AKE# % % Oracle VM
ServerlZfEE L E T,
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g—a—a——=8
Create Netnork Select Servers SelectPorts Configure IP Addresses.
Configure [P Address

[ddressing
UseDHCP (%
Use DHCP
Use DHCP

22 : 7w 74 - &KOracle VM ServerlZIP7 KL R 1EHZIEE
[XI23i%, 4-Oracle VM Server CHE SNT2BDONRT Y w7 « Ry NTU—2 ZRLET,

OQACLE VM Manager

View » Took v Actons v Heb v

L ae
| B Hardware
[EET storaoe N
%3 Unassigned Servers |"‘-"‘5°"'“'t
B wyservers
B mysene2
B ysenert
&
—r
[port Status.
MyServer L Bond Port (1)
MyServes2 Bond Port (1)
MyServer3 Bond Port (1)
o5 | u!!lj
=T
I ¥ Jobs
LasRtiese, Descrioton [sttes IMessage [ asen
| gl terdnare || Edt Nebwerk 10, 196.36.0 (New Name: Management network) Completed At |
Jobs q@ ) i | &

B23 : EREDFHLILVATY v Y -y bT—Y
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1Jyy—RELTHOREMACT FLRXDERK

HY—ri—« F—LDIER

( ( ] Oracle VM Manager ]
' =EALT. &8
=5 | ! MACE 1) Y—ZA a
| LTHR |
\ L J J

KBOVNER Ry NU—27 « #Z 7%, Oracle VM4 A b@f}i,u‘/f +—F> kT KLz (MAC) @
T—NVEAERT H Z & TF, Oracle VMA 2 RBMERLEN D 7=ONS, (REEA —H Ry b« T RLART —
NNBT U NIEHD Y TERET, FFEDOMACT K LA %%m@Oraole VMZ Z MZHE Y 4TH &
FAMRE T A, HBDORT v FTRT L HIT, Oracle VMERRE L, T 0 & LITHEID 2T 572 TMAC
T RUVREERTLZMLERDHY 77,

KO8R T EHIC, £, 2—H— - A X T x2—R LEHODToolsFVE T « A==2—m5 [Vnic
Manager| R L E7,

v

Acl_e " VM Manager

e e e
ven- J /2R i -
1 Network Use
Neme | Eeve | GEm e T oo Vet [VLAN Segient
Management | Heartbeat il ey Machine |
Public network. L'
Management netuork
& L
CoumnsHdden 1
et
L v scaments N
& Ports ' IR Ethernet Ports |
Vews | &2 Port Name [IP Address [Port sans
[Port Name
< | >
+ Jabs |
Description [stetus message Abort
o Home ‘ Refresh Fie System MyServerPoaF51 Completed hbort | &
B redvare | Refresh Fie system MyserverposESL Completed Abort
L

Copyright © 2007, 2011 Orade andjor its afffiates. All rights

24 : Tools FILE Y « A=a—m5 Vnic Manager] %:&iR

Vnick A 7 a7, ED3IODOE T T MR L, Boh7216iEHE AN LT WIDO3IO>DE T T v b
IIZEFAT), [Generate] ZFR L £,
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Bl [ Virtual Network Interface Card Manager

"MAC Selector
Specify & unique starting MAC address or collsions may ocour if you are running multiie OVIM Manager Server
appications. Press the Next button to see what starting range is avaiible.

Specify an Tritisl MAC Adcress: _Next.
06 ) [B [l [0 [0 : [0
Number 6fMACs to generate: | 10 ] ‘

Manage MAC Addresses
vew - | 3
MAC Address [EtbemetNetwork _|Virtual Madhine
00:21:16:00:00:00
100:21:66:00:00:01

00:21:/8:00:00:08
00:21:/5100:00:08

B25 : Vnic Manager¥ 4 7 A% - RY 2 AOMACT KL R - Sz HRL—4

MACT RLADT— A REMINTZ5, [Close] ZFINLET, 21T, MACT FL 2D 7 —/LH3FIH
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i J [Delete MyServer Im Compietad Abort Detais
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